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Abstract 
Correlative microscopy experiments require the co-registration of the image data acquired 

by different micro-analytical techniques. Major challenges are the potentially very different 

fields-of-view and resolutions as well as the multi-modality of the data. To provide 

microscopists with an easy-to-use software for two-dimensional image co-registration we 

have developed Correlia, an open-source software based on ImageJ1/Fiji2, which is fully 

tailored for the registration of multi-modal microscopy data. It can handle data-sets of in 

principle arbitrary extent and uses classical  approaches, i.e. rigid registration tools or B-

spline based deformation models for the correction of both, global and local misalignments, 

such that a fast registration output is provided. Here we describe some of the basics of 

Correlia focussing on its application: firstly, registration workflows are outlined on 

artificial data. In the second part these recipes are applied to register correlative data 

acquired on an algal biofilm and a soil sample. 

Introduction 
Correlative microscopy is considered the key to understanding complex biological systems 

on a microscopic scale. One advantage of correlative microscopy lies in the possibility to 

combine different high-resolution microscopy tools which provide structural details of the 

specimen (but are chemically-blind) with microanalytical techniques of high chemical- or 

isotopic sensitivity (but lower spatial resolution) (Caplan et al. 2011; de Boer, 

Hoogenboom, and Giepmans 2015). Another reason to “go correlative” is that it allows for 

bridging large scales, i.e. ranging from bird's eye view to ant's view perspective in order to 

understand the structural and chemical properties. To give an example: one may think of a 

complex soil sample in which the interplay of plant-roots, soil aggregates, minerals, 

microbes and small animals like nematodes and earthworms can only be comprehensively 

understood if it is looked at on different fields-of-view ranging from the centimetre to the 

sub-micron scale, as the one method helps to localise the microorganisms, while others 

may provide insight to details concerning the microorganisms and their mutual interplay 
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as well as their interaction with the environment. These and many more aspects were 

already sketched in a topical review entitled “The 2018 correlative microscopy techniques 

roadmap” by Ando et al. (Ando et al. 2018). 

The challenges arising from the ambitious endeavour of conducting correlative microscopy 

and micro analytics on different scales are manifold. A very basic aspect is that protocols 

for the preparation of the samples have to compromise between a reasonable preservation 

of the (ultra-)structure of the specimen, while at the same time keeping the chemical 

composition of the specimen mostly intact. Another point is that imaging workflows have 

to be thoroughly planned with respect to the destructive properties of each technique such 

that if technique A and technique B are used in sequence the results of B are not 

significantly altered by A. Further, some difficulty to relocate one and the same field-of-

view in different microscopies might only be overcome by introducing extrinsic marks, 

e.g. laser marking the sample, or sample holders particularly designed for that purpose. A 

solution for the latter has been commercialised by Carl Zeiss Microscopy (using the 

“Shuttle and Find” module of the ATLAS3 software). 

Correlative light-electron microscopy (CLEM) is probably the best-known variant of 

correlative microscopy. However, workflows combining imaging with micro-analytical 

techniques, e.g. fluorescence in-situ hybridisation combined with nanoSIMS (Musat et al. 

2012) or EM and SIMS (Eswara et al. 2019) demonstrate the combinatorial large potential 

of correlative schemes. For a review on sub-cellular imaging using correlative workflows 

see (Decelle et al. 2020). 

Correlative microscopy experiments require joining the data and deriving additional 

knowledge from their correlation which usually requires the co-registration of the 

micrographs onto each other. This in general requires (i) identification of similarities in the 

moving image (source micrograph) and the target micrographs and can be realised as 

feature or area-based, (ii) optimisation of a cost function, (iii) selection of a transformation 

model and (iv) accomplishment of the transformation and resampling of the source 

micrograph. 

There are two basic challenges: firstly, if arbitrary microscopic modalities are to be 

combined, as Decelle et al. (Decelle et al. 2020) are outlining, there is no embedded 

solution available (i.e., in practical research the smallest common denominator often 

enough are digital micrographs in TIFF4 which will have to be imported and registered). 

Secondly, the workflows may demand further preparation steps (e.g. drying, metallisation 
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etc.) “on the way”, such that various sources for deformations occur in the samples which 

will require deformable image co-registration. The latter, however, has been considered 

since several decades in the biomedical field, not only for radiology, but also for histology, 

as was done e.g. in own work for the 3D reconstruction of tumour tissue based on large 

histological serial sections (Braumann et al. 2005), (Wentzensen et al. 2007), (Braumann 

et al. 2007). In fact, correlative microscopy appears to be the most challenging field of 

application for deformable image co-registration due to the very broad range of types of 

micrographs. 

Ready-to-use software packages for image co-registration tasks are since long existing. 

One popular is the Insight Segmentation and Registration Toolkit (Insight Toolkit - ITK5) 

(McCormick et al. 2014). ITK is written in C++6 and was wrapped for Python7, whereas 

some dedicated multiple wrapping interface called SimpleITK8 (Yaniv et al. 2019) enables 

ITK usage from  C++, Python, R9, Java10, C#11, Lua12, Ruby13 and Tcl14. ITK is providing 

rigid, affine and quite a few deformable registration methods, and is also extendable using 

plug-ins for registration tasks. One of such plug-ins is elastix15 (Klein et al. 2010) offering 

implementations of B-splines (with an arbitrary interpolation order), also thin plate splines, 

and elastic body splines. Since Elastix16 (with capital E) (Tischer 2019) is an ImageJ/Fiji 

wrapper (with some GUI) for elastix, it is still not included in Fiji, but of course is 
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applicable therein. bUnwarpJ17 (Arganda-Carreras et al. 2006) is implemented in Java and 

is providing cubic B-spline based registration plus some consistency restriction in favour 

of an invertability of the solution and is included in Fiji. BigWarp18 (Bogovic et al. 2016) 

is also Java based and is using thin plate splines. It is also included in Fiji, while its 

functionality lags behind bUnwarpJ. TrakEM219 (Cardona et al. 2012) is also written in 

Java, but offers lots of overall functionality, i.e. manual segmentation, semantic 

segmentation, skeletonisation, measurements, 3D visualization, image annotation, and also 

image registration, while the latter is directly based on bUnwarpJ. One might have thought 

that the well-known OpenCV20 (an open source computer vision software library written 

in C/C++ which can be wrapped for Python, Java, Matlab21 and Octave22) does include 

registration with some non-linear image deformation functionality. However, this is 

missing so far in OpenCV, there are only some affine and projective transformation models 

implemented yet, so OpenCV presently cannot be considered for image co-registration in 

correlative microscopy. 

Amongst the existing software for co-registration of multi-modal image data-sets  easy 

cell-correlative light to electron microscopy (eC-CLEM)23 24 (Paul-Gilloteaux et al. 2017) 

is the most prominent solution particularily designed for CLEM. It is a plugin for  Icy25, a 

software issued by the Institut Pasteur and France-BioImaging providing a “high-end visual 

programming framework for seamless development of sophisticated imaging workflows” 

as it is described in (de Chaumont et al. 2012) (whereas Icy in turn can include ImageJ 

within its GUI). eC-CLEM has a few unique features, e.g. 3D light microscopies can be co-

registered with electron microscopies (2D), it has some integrated image pre-processing 

and some very intuitive manual/interactive registration using landmarks or reference lines. 
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To our knowledge, eC-CLEM presently is acknowledged in the correlative microscopy 

scientific community, it includes a deformable registration mode based on spline 

interpolation. Together with  an additional module, the so called AutoFinder26 which does 

some automatic pre-registration, eC-CLEM can be considered very useful for many 

practical applications, whereas a few open issues remain: it can handle just single image 

pairs for co-registration, it cannot deal with series (cascades) of image registration steps in 

an arbitrary sequence (except rigid followed by deformable), it does not include some area-

based similarity measure, and it cannot handle visualisations of more than two co-

registered images. Some of these aspects, however, are essential for a much broader 

inclusion of imaging modalities, like nanoSIMS. 

Inglada and Giros (Inglada and Giros 2004) adopted several area based similarity measures 

for multimodal images, including Kolmogorov distance and mutual information (MI; one 

of the most important similarity measures for multi-modal image registration). Different 

strategies for the registration of highly multimodal CLEM data are described in the PhD 

thesis27 of Toledo-Acosta  (Toledo Acosta 2018). To the best of our knowledge, there are 

no tools described yet that provide suitable similarity measures for multimodal images, 

nonlinear registration methods, and an integrated solution for management and 

visualisation of multiple correlative images at the same time. Therefore we have developed 

a new software for exactly that purpose: Correlia, an ImageJ plug-in to organise, co-

register and visualise multimodal correlative data-sets (Rohde, Braumann, and Schmidt 

2020). 

 

Models for image co-registration 
 

Lots of work had been done in the past decades concerning image co-registration (origins 

thereof go far back to the beginnings of remote sensing), see the famous systematisation 

done by Gottesfeld Brown (Brown 1992), or some newer review by Zitová and Flusser 

(Zitová and Flusser 2003), while another extensive review with respect just to the non-

linear (deformable, warping) registration methods was given by Sotiras et al. (Sotiras, 

Davatzikos, and Paragios 2013). When designing Correlia it had been very clear to us that 

the software must allow for compensating such mutually non-linear image deformations. 

According to the categorisation done by Sotiras et al., geometric transformations may 
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either be derived from physical models or from interpolation theory. As was already 

mentioned above, the use of cubic B-splines was preferred for this work, which obviously 

are based on interpolation theory. To not consider physical models for Correlia so far and 

to use good old interpolation based ones has a few reasons, (i) as for correlative microscopy 

in its entirety we have to deal with deformations of a broad variety of causes, it is difficult 

to estimate physical properties like elasticity. (ii) the computational complexity of 

geometric transformations derived from physical model is considereably higher than for 

those derived from interpolation theory, as the former, also referred to as non-parametric 

registration approaches (see e.g. (Modersitzki 2003), (Fischer and Modersitzki 2004), and 

(Modersitzki 2009), or own work (Braumann and Kuska 2005), (Braumann and Kuska 

2006), (Kuska, Scheibe, and Braumann 2008) and (Scheibe et al.)), are usually based on 

systems of partial differential equations (PDEs). Compared to, say, spline based approaches 

PDE-based iterative approaches presently do not allow for interactive applications so far 

(however, ITK already includes some publicly available GPU-adapted implementation of 

PDE-based image deformable registration methods28, these might be considered in future; 

also see the MATLAB-implementations by Modersitzki et al. for FAIR: Flexible Algorithms 

for Image Registration29). (iii) for Correlia we were preferring some existing ImageJ-

related implementation30 of interpolation theory based methods, so the plug-in of choice 

became bUnwarpJ. The cubic B-spline based method implemented in bUnwarpJ uses a 

consistency restriction making sure that the result can be inverted, which guarantees 

topology preservation, a reasonable property for image registration in general. 

Correlia 
In this section a quick introduction to the software Correlia is given which we hope will 

enable the reader to use the software for organising, registering and visualising her 2D 

correlative microscopy data-sets. We will start with a short paragraph on downloading and 

integrating Correlia into an ImageJ/Fiji installation. Subsequently, a flow chart for the 

registration of correlative microscopy data is presented and artificial data-sets are 

employed to illustrate the different options Correlia provides for rigid and deformable 

image registration.  

Installation of the software 

Correlia can in principle be installed on any computer with a Java 8 (or following versions) 

runtime environment installed on it and therefore does not depend on a particular operating 
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system. We are not exactly sure what the absolute minimum hardware requirements for 

running Correlia are, but so far any modern laptop with at least 2 GB of RAM, a dual core 

processor and full-HD screen resolution was good enough. However, parts of the 

programme (in particular the visualisation engine) are already parallelised such that the 

user will benefit from better machine performance, further parallelisation of the code is 

planned. On the software side Correlia requires a ImageJ/Fiji distribution with the plug-in 

bUnwarpJ (Arganda-Carreras et al. 2006) installed. Fiji is preferable over ImageJ because 

it is bundled with bUnwarpJ. It can be downloaded from 

https://imagej.net/Fiji/Downloads. (The time stamp of the Fiji distribution used in this 

paper is 2019-11-15.) If an ImageJ distribution is being used, bUnwarpJ has to be installed 

as well. It can be downloaded from https://imagej.net/BUnwarpJ. 

Installing Correlia is as straight forward as installing any other Fiji plug-in and can be done 

in three steps: 

 download the compiled jar-package correlia.jar from http://www.ufz.de/correlia 

 move ufz-correlia.jar to the plugins directory of the ImageJ/Fiji installation 

 restart ImageJ/Fiji 

Now Correlia should be installed and can be run from the Fiji menu Plugins → Registration 

→ Correlia. bUnwarpJ will reside in the same menu, but there is no need to directly invoke 

it. 

 

Correlia is open source software and can naturally be built from the source code. It is 

beyond the scope of this chapter to give a full description on how to do that. However, a 

step by step manual as well as a link to the Git-repository with the source can be found on 

http://www.ufz.de/correlia. 

 

 

A quick guide to image registration with Correlia 

Complexity and flexibility make a software package powerful on the one hand but also 

difficult to learn on the other. The following section will explain the basic aspects of image 

registration with Correlia step by step and will hopefully allow for a smooth and enjoyable 

start with the software. 

 

In preparation of working with Correlia 

Fig. 1 displays a workflow for the registration of a correlative data-set. After the acquisition 

of the image data – micrographs, but also for instance distribution maps of chemical 

elements and compounds as well as isotopes – it can be imported to ImageJ/Fiji. In order 

to later proceed with Correlia it is necessary to calibrate the micrographs properly, in other 

words to tell the software how many pixels correspond to a physical length unit, e.g. 

microns. Provided the microscopes are properly calibrated this relation is known (for 

instance from scale bars) and should be provided to ImageJ/Fiji using the function Analyze 

→ Tools → Set Scale. If the respective image format is supported by the Bio-Formats31 
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plug-in (Linkert et al. 2010) the image data can be imported using this plug-in and will 

immediately be calibrated correctly. Afterwards it is important to save the calibrated 

micrographs on the hard-drive in TIFF. TIFF is native to ImageJ/Fiji and allows for writing 

the calibration and other useful information to the header. If other image formats are used, 

e.g. JPEG, PNG, BMP etc., this information will be lost! 

Starting a Correlia project 

Now the data-set is ready to be treated with Correlia. For that Correlia has to be launched 

from the ImageJ/Fiji menu Plugins → Registration → Correlia. Now the user has to select 

one micrograph in the data-set to become the “canvas” (in Correlia referred to as “base 

image”) onto which the other micrographs should be registered. In general this micrograph 

should have a large field-of-view and reasonably high resolution and at the same time be 

rich in features that can serve as intrinsic markers in the registration process. 

After that, the graphical user interface (GUI) starts and two windows open: the Correlia 

project viewer and the control frame. The project viewer now only shows the base 

micrograph, however, after further import of micrographs it will show one particular user-

defined representation of the data-set, we will come to that later. Let’s turn to the control 

frame of the GUI which is displayed in Fig. 2. On the left side a list of all micrographs of 

the project is displayed, which at the moment only contains the base micrograph. A click 

on the “+”-button below the list opens the import dialogue such that more micrographs can 

be imported to the project and are displayed in the list. Selecting a micrograph from the list 

will display a preview as well as its coordinates relative to the base image on the right side 

of the main frame. The coordinates allow for a linear (rigid body) transformation; this is 

translation, rotation and scaling. For rapid pre-alignment the user can set these coordinates 

manually by typing or clicking on the arrows. 

 

Rigid body registration 

After a reasonable manual pre-alignment of the selected micrograph it is ready for rigid 

body registration. In Correlia this can be done 

 manually by defining and matching corresponding landmarks in moving image and 

target or 

 automatically by maximising the mutual information of moving image and target. 

 

Fig. 3 illustrates the registration of an artificially blurred test image containing geometrical 

objects (moving image) onto a non-blurred image containing the same objects but also a 

chess-board background which is used as base image (target). This test-case relates to the 

real-life scenario of registering a fluorescence microscopy data with certain fluorescent 

objects onto electron micrographs which are rich in details. 

The top row shows the situation directly after the import of the moving image (left) and a 

manual pre-alignment (right). For manual registration landmarks were defined at some of 

the corners of the triangles as well as in the centres of the circles and matched. In order to 

define landmarks right-click on the previews of the moving image as well as the target 

image in the Correlia control frame. This will open the two micrographs in separate 

windows with the point-selection tool (build-in feature of ImageJ) selected as depicted in 

Fig. 4A. By point-and-click the landmarks can be defined. After closing the micrograph 

windows the corresponding landmarks have to be matched by selecting “Align via 



features” from the Correlia menu “Image”. This will open the “Match features” dialogue 

and a preview, Fig. 4B. After acceptance of the correspondences the bottom left image of 

Fig. 3 was obtained. 

Admittedly, the registration is far from perfect because only seven points were used for 

registration and the remaining image content was simply ignored. On top of that, these 

points were not even well defined in the moving image because of the blurring. A better 

result was obtained with automatic registration using mutual information, which is shown 

in the bottom right of Fig. 3. Here the triangles and circles appear to be better aligned 

because more image content was used for the registration. 

In conclusion, in most cases we recommend to do a thorough manual pre-alignment of the 

moving image followed by the automatic registration. However, in cases of very different 

image content (e.g. due to very different modality) putting landmarks to features that can 

be recognised in the moving as well as the target image may be the only way to register.  

 

Deformable registration (de-warping) 

In many practical cases rigid body registration of micrographs already meets the 

requirements of the user if the moving image is free of significant distortions. These, 

however, cannot always be avoided. On the one hand the sample might deteriorate during 

a measurement, for instance due to heat generation under the beam of a laser scanning or 

an electron microscope. On the other hand the correlative microscopy workflow might 

demand a sample preparation step in between two measurements, which may modify the 

sample and thereby introduce distortions. Imagine for instance, that in between light and 

electron microscopy the sample is dehydrated and dried in order to make it vacuum-

compatible. This may cause shrinkage or even cracks in the sample which, naturally, result 

in distortions in the electron micrograph. 

In order to register a distorted micrograph properly onto another – ideally distortion-free – 

modality a non-linear transformation model has to be applied that de-warps the distorted 

micrograph. Following Sotiras et al. we will in the following refer to such a registration 

step as deformable registration (Sotiras, Davatzikos, and Paragios 2013). According to the 

general workflow for image registration with Correlia, displayed in Fig. 1, the user has to 

make a choice between de-warping the image based on either landmark-matching or areal 

similarities. The decision structure shown in Fig. 5 shows the different strategies for 

deformable registration implemented in Correlia. A click on the icon “deformable 

registration” in the main frame (Fig. 2) will change the user interface to deformable 

transformation mode shown in Fig. 6. Here the user can select from four different strategies 

to transform the moving image which shall be outlined in the following. An arbitrary 

number of transformations steps can be cascaded in order to achieve best registration 

results. Please note that successful registrations can be saved as recipes for future use. 

Let’s turn back to Fig. 5 and discuss the options for deformable registration. If the 

similarities in moving image and target are mainly features, e.g. pin-points or edges, it is 

advisable to define several features that can be matched by deforming the moving image. 

In Correlia this can be achieved with either “landmarks matching” or using the external 

plug-in bUnwarpJ. The first option has the advantage that the warping can be carried out 

such that all defined landmarks will be matched exactly. However, the downside is that this 

may introduce undesired strong distortions in their vicinity. In such cases bUnwarpJ is the 

method of choice: the plug-in allows for compromising between feature alignment 



accuracy and the extent of image transformation. The effect of deformable registration by 

matching landmarks is shown in Fig. 7. 

Otherwise, if moving image and target image show common areal similarities -  even if 

these objects are represented by different pixel intensities, e.g. bright in one image and dark 

in the other - warping methods based on mutual information can be used: Firstly, the “tile 

matching” approach divides the moving image into overlapping tiles. For each tile the best 

corresponding area in the target image is determined. The centres of those areas are 

considered as matching features. This approach works well for large scale deformations. 

However it cannot be applied to localised distortions as tiles cannot be arbitrary small. 

Secondly, the global mutual information (global MI) method computes the similarity on 

the whole images while iteratively modifying the transformation model. The control points 

for the transformation can be distributed over the whole image or a specific region of 

interest. More control points result in a flexible model but also in an increased 

computational expense. Fig. 8 displays how artificial data is deformable registered with 

both tile matching and global MI. 

 

Visualisation 

A meaningful visualisation of a correlative data-set, naturally, will not display all co-

registered micrographs overlaid in one image. Rather, different subsets of micrographs and 

false-coloured chemical maps are selected in order to visualise particular aspects of the 

data. For that, the micrographs in a correlative project can either be excluded from 

visualisation, overlaid fully opaquely or overlaid additively in user-defined false colours. 

Furthermore it is possible to enhance the contrast of a certain modality. 

Two real-life examples 

Distribution of phosphorous in an algal biofilm 

Rationale: 

Phosphorous plays an essential role as fertiliser in agriculture and can lead to 

eutrophication of waterbodies if present at high levels in wastewater effluents. Microalgal 

biofilms are known to remove phosphorous from these and therefore have the potential to 

be used in wastewater treatment plants for this purpose. In their recent study Moreno-

Osorio and colleagues employed correlative microscopy to investigate the architecture of 

Chlorella biofilms grown on cotton fabric (Osorio et al. 2019). One aspect of this study 

was to cultivate the biofilms under phosphorous-rich conditions and investigate whether 

the algae would store the excess phosphorous either intracellular or within the biofilm 

matrix. 

Here, an algal biofilm from this work shall serve as an example for deformable registration 

with Correlia. For that the structure of the biofilm was investigated by scanning electron 

microscopy (SEM), and the distribution of phosphorous in the biofilm was measured by 

energy dispersive X-ray spectroscopy (EDS) in the same SEM. During the EDS 



measurement the biofilm degraded under the electron beam such that the phosphorous map 

contains distortions. We will show how the phosphorous map can be registered onto the SE 

micrograph, though. 

Sample and microscopy equipment 

The details of sample growth and preparation for microscopy are given in (Osorio et al. 

2019). In brief they are: An algal biofilm of Chlorella vulgaris ACUF 809 was cultivated 

on cotton fabric for 5 days. In preparation of electron microscopy the biofilm was 

chemically fixed with 4% of paraformaldehyde solution, dehydrated in a graded ethanol 

series and critical point dried. It was then glued onto standard SEM sample holders (stubs) 

and sputter-coated with a chromium layer of 20nm thickness. 

The analysis was performed with a Zeiss Merlin VP Compact (Carl Zeiss Microscopy, 

Oberkochen, Germany) field-emission scanning electron microscope coupled with an 

annular Bruker XFlash Quad 5060F (Bruker Nano GmbH, Berlin, Germany) EDS detector. 

The electron acceleration energy amounted to 3kV which allowed for obtaining reasonable 

surface sensitivity but at the same time was sufficiently high to excite the K-alpha line of 

phosphorous. The beam current was about 250pA. 

Methods (for image registration) 

Fig. 9 displays SEM data (left) and secondary electron (EDS-SE) image as well as the 

phosphorous distribution map (EDS-P) measured by EDS (right) side by side. For the 

registration of the EDS data onto the SEM image it is very helpful that both micrographs, 

EDS-SE as well as EDS-P, share the same coordinates. In other words, if one of them can 

be registered onto the SE micrograph this transformation can be applied to the other and 

will register this one as well. The EDS secondary electron micrograph is of lower resolution 

then the SEM image. However, in contrast to EDS-P it contains image information similar 

to the SEM image rendering registration of this modality easier compared to EDS-P. 

Following the workflow Fig. 1 the micrographs require proper calibration in preparation 

of registration with Correlia. For that they were opened in Fiji and calibrated using 

“Analyze → Set Scale”. Before calibrating the EDS data both images were put in an image 

stack32. After calibration, SEM and EDS data were saved in TIFF on the hard-drive. 

Subsequently, Correlia was started with the scanning electron micrograph used as base 

image (canvas). Then the stack of EDS-SE and EDS-P was imported such that both will 

appear as separate images in the Correlia project but with coordinates linked. After setting 

the visualisation-state of EDS-P to “invisible” and a rough manual pre-alignment of EDS-

SE onto the scanning electron micrograph the data was ready for automatic rigid 

                                                 

32
  In general this is advisable for images with identical coordinates. 



registration based on the mutual information similarity measure. The result is displayed in 

Fig. 10 in red (EDS-SE) and green (SEM) colouring in order to visualise the differences. 

Whilst the right-hand side of the micrographs aligns well, it is obvious that in particular 

areas on the left and in the vicinity of the crack in the biofilm significantly degraded under 

the electron beam. There, the misalignment is in the order of half of the size of an algal 

cell. Thus, if the registration were terminated at that point and the rigid transformation of 

EDS-SE was applied to EDS-P it cannot no be decided whether the phosphorous hot spots 

are inside or outside the algal cells. Therefore further deformable registration steps are 

required. 

The majority of distortions in EDS-SE are areal and extended rather than localised. In such 

cases the strategy for deformable registration, Fig. 5, suggests to use the tile matching 

approach. It was clear that the algorithm should be permitted to use the entire deformation 

scale to de-warp because distortions in the EDS data could neither be classified merely 

small or large in size. After some trial and error we found that best results were obtained 

by distributing many small tiles rather than a couple of large ones, therefore the number of 

tiles (per column/row) was set to six. The result, displayed as red-green difference 

representation, is shown in Fig. 11 together with a screenshot of the Correlia dialogue. 

This first de-warping eradicated a number of the extended distortions in EDS-SE, however, 

further improvement is needed along the crack line through the biofilm on the left side. 

Since remaining distortions are mostly localised, the strategy (Fig. 5) is to use landmarks 

based deformable registration either by strict landmark matching or using the external plug-

in bUnwarpJ. We decided to go for the first option and distributed 75 landmarks over the 

SEM image as well as EDS-SE. The result after matching the landmarks is displayed in 

Fig. 12. The accuracy of the registration is, excepting a few bacteria and filaments of 

exopolymeric substances, better than one tenth of the size of an algal cell and therefore 

suffices for answering the initial question whether phosphorous deposits are in- or outside 

the algal cells. Switching the visualisation state of EDS-SE to “invisible” and that of EDS-

P to “enhanced” in red colour yields Fig. 13. Now it is clear that the microalgae store excess 

phosphorous inside the cells rather than in the biofilm which is in line with the time-of-

flight secondary ion mass spectroscopy data published in (Osorio et al. 2019). 

Alternatives and troubleshooting 

There is no such thing as the “golden trail“ to perfect registration, and a similar result could 

have been obtained using other registration possibilities implemented in Correlia. For 

instance, rigid registration by defining and matching corresponding landmarks in the target 

and the moving image will result in a reasonable prealignment as well. Also, as first elastic 

registration step one could have used the global mutual information algorithm instead of 

tile matching. This, as said earlier, is recommended if the areal distortions in the moving 



image can be regarded localised rather than extended. An alternative for the second 

deformable registration step, in which we went for strict matching of landmarks, could be 

using the bUnwarpJ-based deformable registration approach in Correlia. The difference is 

that instead of matching landmarks absolutely perfectly (no matter if that requires the 

introduction of new areal distortions in the moving image, cp. Fig. 7A and B) bUnwarpJ 

un-warps the moving image with respect to matching of landmarks on the one hand but 

also keeping the deformation-introduced distortions small on the other. The user may put 

more weight for compromising onto either landmarks or areal similarities, cp. Fig. 7B, C 

and D. 

Summary 

This example showed how interlinked micrographs which share their coordinates because 

they were acquired together in the same experiment (here EDS-SE and EDS-P) can be 

registered onto another micrograph (SEM) by merely registering the most suitable modality 

(here EDS-SE) and applying the transformation model to the other (EDS-P). This 

piggyback approach is suitable for many microanalytical techniques producing a number 

of for instance chemical distribution maps at the same time. Furthermore the example 

illustrated how distortions in the moving image can be un-warped in two subsequent 

deformable registration steps using Correlia. 

Microscopic analysis of a soil sample - An image registration 
workflow 

Rationale: 

Studying the interplay of plant roots, mineral particles, organic matter and microbes in soil 

is a complicated matter. It requires a sample preparation that allows for structural analysis 

from the centimetre down to the sub-micrometre scale with respect to root geometry, pores 

etc. At the same time the chemical composition of the soil sample must not be disturbed 

significantly such that micro-analytical techniques can be employed to measure chemical 

gradients and matter fluxes (of for instance carbon or nitrogen) in the vicinity of a root. 

Recently Schlüter, Eickhorst and Mueller (Schlüter, Eickhorst, and Mueller 2019) 

published a novel protocol for correlative imaging of soil. It combines computer 

tomography for the acquisition of a 3D-tomogram of the soil core with 2D microscopy and 

micro-analytics measured on a plane dissecting the core physically by sawing and 

polishing. 

Here, we demonstrate how Correlia can be used for the registration of several 2D data 

acquired on a similar sample which was prepared and provided by one of the authors of the 

referenced study (S. Schlüter). The example shows Correlia's capability to handle medium-

size data-sets comprising micrographs and maps of various modalities acquired on fields-

of-view that differ by about two orders of magnitude. 



Sample and microscopy equipment: 

The sample is soil that was chemically fixed, dehydrated, embedded in epoxy-resin, sawn 

with a diamond saw and polished. The structural analysis of the so-prepared sample was 

carried out by 

 a Sensofar SNeox 3D optical profilometer, Sensofar Metrology, Terrassa, Spain 

 a Zeiss Orion NanoFab scanning helium-ion microscope, Zeiss Peabody, MA, 

USA. 

The atomic composition of the sample was checked with a 

 Bruker QUANTAX FlatQUAD energy-dispersive X-ray spectrometer, Bruker 

Nanoanalytics, Berlin, Germany mounted in a 

 Zeiss Merlin VP Compact scanning electron microscope, Carl Zeiss Microscopy, 

Oberkochen, Germany. 

Chemical micro-analysis was performed with 

 an IONTOF ToF.SIMS5 time-of-flight secondary ion mass spectrometer, IONTOF, 

Münster, Germany. 

Methods: 

We present a workflow for the correlative analysis of the soil sample where acquisition and 

registration of microscopic data are closely entangled. Basically, it consists of the following 

steps: 

1. acquisition of an overview map, in the following referred to as treasure map, by 

stitching many fields-of-view acquired by optical microscopy at low magnification 

2. identification of a region of interest (ROI) which contains a plant root 

3. start a new Correlia project with the part of the treasure map that contains the ROI 

which serves as canvas for the registration of subsequently acquired micrographs 

4. structural analysis of the vicinity of the root by high-resolution helium-ion 

microscopy 

5. registration of the helium-ion microscopy (HIM) data onto treasure map 

6. topography measurement by optical profilometry at high-resolution 

7. registration of the topography map onto the HIM image 

8. chemical micro-analysis by time-of-flight secondary ion-mass spectrometry (ToF-

SIMS) 



9. rigid and deformable registration of the ToF-SIMS data onto HIM image 

10. metallisation (sputter-coating) of the sample with Au/Pd (80:20) in preparation of 

energy dispersive X-ray spectroscopy (EDS) 

11. analysis of the atomic composition of the minerals in the vicinity of the root by 

EDS 

M1, M2 - Acquisition of a treasure map and identification of areas of interest 

Experimentally the correlative workflow has to be planned carefully with respect to the 

effects of the different micro-analytical techniques on the soil sample. It is also important 

that such a workflow contains the acquisition of a treasure map to have a reference for 

navigation on the sample which allows for conveniently finding back regions of interest 

(ROIs) in the different microscopes. A treasure map can in principle be obtained by any 

microscope capable of measuring at sufficiently large field-of-view with sufficiently large 

depth of focus at medium resolution. It is important that the treasure map contains at least 

some structural information of all parts of the sample. (Fluorescence microscopy for 

instance would not be a good choice since non-fluorescent areas will appear dark and thus 

are free of information.) This ensures that at least in principle any object of choice 

appearing in the micrographs and chemical maps acquired subsequently can be used to 

register these onto the treasure map. 

Having that in mind the embedded soil sample was put under the optical profilometer 

which in principle is an optical microscope suitable to measure samples with a surface 

topography. For that it uses focus-variation to acquire a z-stack of planes of which only 

certain areas are in focus. From this z-stack an algorithm known as focus stacking 

calculates an all-focussed micrograph as well as a height map of the surface. Furthermore 

the instrument allows for stitching together many fields-of-view such that an almost 

arbitrarily large map can be obtained.  

In this case a 10× objective was used and 6×6 fields-of-view were stitched together 

resulting in a map  8.1×7.3mm2 at an isotropic pixel-size of about 1.3µm. On the treasure 

map an area of interest containing a plant root was identified as indicated on the left of Fig. 

15. In principle the correctly calibrated treasure map could serve as canvas (base image) 

for the Correlia project. However, none of the following analyses was to be conducted 

outside the ROI. Thus it appears to be more convenient on the one hand, but also memory-

saving on the other to start the Correlia project with a highly resolved map of the ROI. 

With that in mind, a second, more detailed bright-field micrograph of the ROI was acquired 

with the optical profilometer using a 50× objective and stitching 5×6 fields of view such 

that an area of 1600×1450µm2 resolved at 6253×5632pixels2 was obtained (inset of Fig. 

15, left) . 



M3 - Start a new Correlia project 

In order to start a new Correlia project with the optical profilometer micrograph of the ROI 

as canvas (base image) correct calibration of the same has to be ensured. For that the 

micrograph was opened with Fiji and using Analyze → Set Scale it was checked that 1µm 

equals 3.88pixels. Then Correlia was started from the “Plugins” menu and the calibrated 

micrograph was used as canvas (base image).  At this point it is good practice to title the 

project properly and leave some information about the sample and the purpose of the study. 

This can be done by calling “Project→Project Properties” from the Correlia main frame. 

M4, M5 - Scanning helium ion microscopy 

The resolution of optical microscopy is restricted to about 0.3µm due to the Abbe limit. 

Higher lateral resolution can for instance be obtained with either SEM or HIM. For the 

non-conductive soil-sample HIM appeared to be the more suitable technique because it has 

the advantage of larger depth-of-field compared to SEM (Ward, Notte, and Economou 

2006) and the possibility of efficient charge compensation. The electron flood gun of the 

HIM allows for compensating the implanted positive charges of the He+ ions after each 

scanned line and in turn does not require carbon-coating or metallisation of the sample 

which normally has to be done prior to SEM analysis33. 

The sample was subjected to HIM analysis using an ion-landing energy of 25kV and 

secondary electron detection. With the aid of the treasure map the area of interest was 

quickly found back and an overview image as well as a micrograph revealing details of the 

surrounding of the root were acquired. The HIM overview was manually registered onto 

the bright-field micrograph matching landmarks. The result is shown on the right side of 

Fig. 15 with the root encircled. It is obvious that the modalities are too different to be 

automatically registered: Whilst HIM mainly shows a topography contrast with a probing 

depth of only a couple of nanometers below the surface, contrast in the bright-field treasure 

map is gained from the reflection of light at the surface, a process happening on length 

scales in the order of at least some wavelengths of the exciting light. 

Fig. 16 depicts the vicinity of the root as shown by the different micro-analytical 

techniques. In sub-figure B the high-resolution HIM image showing the plant-cells is auto-

registered onto the HIM overview. Sub-figure C serves to show the quality of the 

registration of the HIM image (here false-coloured in blue) onto the bright-field image. 

                                                 
33Carl Zeiss Microscopy, White papers: Zeiss Orion Plus (2008) and Zeiss Orion 

NanoFab (2016),https://www.zeiss.com/microscopy/int/products/multiple-ion-

beam/orion-nanofab-for-materials.html. 

https://www.zeiss.com/microscopy/int/products/multiple-ion-beam/orion-nanofab-for-materials.html
https://www.zeiss.com/microscopy/int/products/multiple-ion-beam/orion-nanofab-for-materials.html


M6, M7 - Measurement of the topography in the vicinity of the plant root 

In order to conclude on the quality of the sample preparation, e.g. infiltration of the resin, 

sawing and polishing, the topography was measured with the optical profilometer in the 

vicinity to the plant-root. For that a confocal z-stack was acquired using a 100× objective 

and blue excitation from a light emitting diode. Lateral as well as depth resolution of the 

obtained topography map are better than 0.5µm.  Subsequently the false-coloured map – 

bottom (blue) to top (red) equals 17µm – was imported to the project and rigidly registered 

onto the HIM image using the automatic algorithm. Since in both micrographs the plant-

cells in the root are easily recognised and on top of that the micrographs are almost 

distortion-free a high-quality overlay was obtained, Fig. 16D. Please note that registering 

the topography map onto HIM at the same time registers it onto the treasure map because 

HIM and treasure map had previously been registered. 

M8, M9 – Time-of-flight secondary ion mass spectrometry 

Up to this point only structural information but no chemical information about the sample 

was obtained. In order to gain some insight into the chemical composition of the sample 

ToF-SIMS was employed to measure molecular ion maps. For that, the sample was scanned 

with a beam of bismuth  ion clusters (Bi3
+) (Touboul et al. 2005) allowing for imaging in 

negative ion extraction mode. Since ToF-SIMS acquires a full ion-detection spectrum for 

each pixel, distribution maps for several negatively charge ions are obtained at the same 

time. For demonstrating the process of registration of the ToF-SIMS data we will merely 

focus on the 12C14N- signal (for simplicity in the following referred to as CN-),  which 

serves as a marker for biomass (Benettoni et al. 2019) and the total ion count (TIC) which 

provides structural information similar to HIM. It is important to mention that a ToF-SIMS 

measurement is performed such that the exciting beam hits the sample under an angle of 

45° and that the secondary ions are extracted perpendicularily to the surface. This geometry 

naturally introduces distortions in the obtained maps which will have to be taken into 

consideration for image registration. 

In Fig. 17 HIM and ToF-SIMS data (TIC and CN-) acquired on the root are displayed next 

to each other. In step 1 HIM and TIC were rigidly auto-registered onto each other. The 

false-colour overlay of HIM (green) and TIC (red) shows a reasonable alignment of both 

maps. TIC and CN- maps were acquired in the same measurement and thus share the same 

coordinates which, as in the previous example, allows for linking both and in turn get CN- 

registered onto HIM as well (step 2). The overlay of HIM (green) and CN- (red) suggests 

de-warping. The distortions in CN- are neither purely areal nor can they be considered 

localised. Therefore, two approaches were tried out: in 3a) deformable registration using 

global MI in a ROI around the root with 4×4 control points34 was used, however, only 

                                                 

34 In the software referred to as “deformation handles”. 



minor improvements were achieved. More successful was the usage of bUnwarpJ, step 

3b), by distributing about a dozen landmarks onto the walls of the plant-cells and matching 

them. Fig. 16F shows the heat map of the ToF-SIMS CN- map in the context of the other 

modalities. In conclusion it can be said that, as expected, CN- is a marker for biomass and 

is therefore mainly measured in the root. 

M10, M11 – Chemical analysis of mineral particles by energy- dispersive X-ray 

spectroscopy 

In order to get deeper insight into the mineralogy of the vicinity of the root, which would 

be an important parameter for understanding (bio-)geochemical processes occurring in the 

rhizosphere, element distribution maps were measured by EDS. In preparation of these 

experiments the sample had to be sputter-coated with chromium35 to obtain a conductive 

surface. With the aid of both, bright-field treasure map and HIM, it was easy to find back 

the ROI in the SEM. Similar to the procedure shown in the example of the algal biofilm 

the secondary electron signal EDS-SE was used to register the EDS-maps onto the HIM 

image. For that rigid registration was absolutely sufficient. 

Regarding the image registration functionality of Correlia we could at this point finish this 

example showing an overlay of the EDS data with another modality. However, the EDS 

maps are suitable to demonstrate another useful functionality of Correlia. Fig. 18 shows 

the element distribution maps of sodium, magnesium, aluminium, silicon, potassium and 

iron which are typical components of soil minerals. Looking merely at the chemical 

elements does not reveal the type of minerals present in the sample, though. Silicon, for 

instance, is present in quartz (SiO2) and feldspars (aluminium silicates) as well. In order to 

derive new knowledge from correlative data Correlia has a function to “product correlate” 

images. For that, the image intensity Id(x,y) in the derived image at each data point (x,y) is 

calculated from the normalised36 intensities of the n correlated images at the same point 

Ii(x,y): 

 

 

We applied product correlation to the element maps and derived maps of Na-feldspar (Na, 

Al, Si), K-feldspar (K, Al, Si) and an magnesium, aluminium and iron containing mineral 

which is likely to be pleonast. The residual silicon signal that does not originate from the 

                                                 

35
  Chromium was chosen as its characteristic X-ray lines do not interfere with those of the chemical 

elements of interest in this study, namely C, Na, Mg, Al, Si, P, K and Fe. 

36
  Normalisation is done such that the lowest value (dark) is considered 0 and the point of highest 

intensity is set to 1. 



feldspars very likely originates from quartz minerals. Fig. 19 shows an overlay of these 

mineral maps together and the EDS-C signal (green, mainly indicating the epoxy resin) 

with the HIM image. 

Summary 

In this example we demonstrated how Correlia can be used to organise and register 

medium-sized correlative data-sets. In particular we showed that in principle it is possible 

to register any micrograph in the Correlia project onto any other. We also used the different 

options available to the user to visualise the correlative data in meaningful ways. Finally 

we showed how additional knowledge can be obtained from correctly registered correlative 

data using the product correlation function of Correlia.  

Summary and Conclusions 
In this chapter we demonstrated how the new software Correlia can be used to organise, 

co-register and visualise 2D multi-modal correlative microscopy data-sets interactively, in 

particular using semi-automated procedures. Correlia organises the image data in projects 

which can be extended and annotated at any time in the workflow by the user(s). This may 

be beneficial for microscopists working together, since sharing such a project amongst each 

other is not mere exchange of data but also of context and derived knowledge. 

Using artificial data we outlined general workflows for registration of micrographs and 

micro-analytical maps with Correlia. These typically comprise manual or automatic rigid 

(pre-)registration followed by one or many cascaded deformable registration steps. The 

workflows were tested on real-life data-sets acquired on an algal biofilm and a soil sample. 

In both examples, there were subsets of micrographs originating from the same 

measurement (e.g. a stack of chemical maps) and thus sharing the same coordinates. For 

such cases it proved useful to register one of the micrographs and use the build-in option 

to translate the transformation model to the other micrographs in order to register them as 

well. The examples we used suggest that warped micrographs should be deformably 

registered twice to align properly with the target: In the first step areal distortions are 

treated using either the “global MI” or “tile-matching” algorithms. In the second step 

manually set landmarks in source and target are matched. Moreover the image registrations 

performed on the data acquired on the soil sample showed that the target micrograph for 

registration does not necessarily have to be the same for all modalities but a registered 

micrograph can serve as a target for another modality. Therefore, Correlia allows for 

registering any micrograph in the project onto any other. 

Embracing the idea of gaining additional knowledge by correlating data rather than looking 

at single measurements Correlia offers a function to product-correlate two or more 

previously registered micrographs. The functionality is particularly useful for chemical 



maps since the analytical capabilities of different techniques can be combined. To illustrate 

this we used product-correlation to determine different types of minerals in the vicinity of 

a plant root from elemental maps obtained from energy-dispersive X-ray spectroscopy 

measurements. 

Having registered all micrographs in a data-set the microscopist wants to visualise her work 

in a meaningful way. For that Correlia allows for choosing false colours, switching on and 

off micrographs and enhancing their contrast. In combination with the full power of image-

processing inherited from the Fiji/ImageJ environment correlative data-sets can be turned 

into scientific knowledge and visual art at the same time. 
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Figure 1: Workflow for the registration of correlative micrographs using Correlia. 

Figure 2: Correlia’s graphical user interface. 

Figure 3: Illustration of the two possible ways for rigid body registration in Correlia. The 

moving image only contains some geometrical objects (red) which are supposed to align 

with the black objects on the chess board (target image). On the one hand corresponding 

landmarks can be defined in both, moving image and target which will be matched. On the 

other hand automatic registration using a mutual information approach is possible after a 

manual pre-alignment. 

Figure 4: Rigid body registration using landmarks. A) At least three landmarks are defined 

in moving image and target. B) Afterwards, corresponding features have to be matched. In 

the “Match Features” dialogue the user can either set the correspondences manually or ask 

the software to guess. The feature correspondences are then displayed with light blue lines 

in the viewer. The user acceptance of the correspondences will calculate the coordinates x 

and y as well as rotation and scale that will register the moving image onto the target. 

Figure 5: Rigid body registration cannot lead to a proper image alignment if distortions 

are present in the moving image. However, this can still be achieved by subsequently 

applying one or more of the deformable registration algorithms implemented in Correlia 

to de-warp the moving image. This flow chart shall help to select the most suitable one for 

the given registration problem. 

Figure 6: Correlia’s graphical user interface for deformable image registration. Several 

transformation steps can be cascaded and are listed on the left (here: “tile matching” 

followed by “landmarks”). The chess-board image on the right displays the transformation 

field. The parameters for the selected transformation are shown below. 

Figure 7: If a distorted moving image contains feature-points that have correspondences 

in the target, landmarks can be defined in both and “forced” to align. Correlia supports pure 

landmark-matching but also uses the external plug-in bUnwarpJ. The latter offers the 

possibility to transform the moving image in different ways by putting certain weight on 

image content (img) and landmarks (lm). 

Figure 8: Registration of a moving image with artificial areal distortions onto a non-

distorted but Gaussian-blurred target. After rigid pre-registration the moving image was 

warped to align with the target. For that tile matching with 4 and 25 tiles as well as global 

mutual information using 4 and 16 deformation handles were used, respectively. 



Figure 9: Investigation of the distribution of phosphorous in a biofilm of Chlorella sp. 

microalgae. A scanning electron micrograph (SEM, left) shall be overlaid with energy-

dispersive X-ray spectroscopy maps (SEM-EDS, right). For that the secondary electron 

micrograph of the SEM-EDS data has to be registered onto the SEM image. Once that is 

the done the same transformation can be applied to the phosphorous map which then will 

be registered as well. 

Figure 10: Rigid registration: Difference representation of the result of automatic rigid 

registration of SEM-EDS-SE (red) onto the SEM image (green) taken on the algal biofilm 

displayed in Fig. 9. Whilst the right side of the overlay aligns well, distortions along the 

crack on the left of the overlay are obvious and call for further deformable transformation. 

Figure 11: Deformable registration 1 (tile matching): Difference image of SEM (green) 

overlaid with SEM-EDS secondary electron micrograph (red) of the algal biofilm shown 

in Fig. 9 and 10 after the first deformable registration using the tile matching approach. 

The tile matching was carried out with 6x6 tiles distributed over the source micrograph 

allowing for full deformation scale. In particular on the left side of the image a significant 

improvement of the registration was achieved. 

Figure 12: Deformable registration 2 (landmarks matching): After rigid pre-alignment 

(Fig. 10) and a deformable registration step (tile matching, Fig. 11) a final deformable 

registration step using landmarks matching is employed to properly register SEM image 

(green) and SEM-EDS secondary electron micrograph (red) acquired on a Chlorella sp. 

biofilm. In the upper part of the figure the distribution of landmarks in both micrographs 

is shown. The lower part shows the registration result after matching them. 

Figure 13: Application of the transformation model obtained by deformable registration 

of the SEM-EDS secondary electron micrograph onto the SEM image measured on the 

algal biofilm of Chlorella sp. microalgae (Fig. 12) to SEM-EDS phosphorous distribution 

map (shown in red). This overlay with the SEM image shows that the microalgae store 

excess phosphorous inside the cells rather than in the matrix of exopolymeric substances 

in the biofilm. 

Figure 14: Workflow illustrating the sequence of microscopic analyses of the soil sample 

and at the same time the sequence of image registration applied to the so obtained 

correlative microscopy data. 

Figure 15: Treasure maps acquired on the soil sample. A) Stitched bright field image of 

the sample with the region of interest indicated and magnified. A root is found and encircled 

in white. B) The bright-field image of the region of interest serving as canvas (base image) 

for the Correlia project is overlaid with a helium-ion micrograph. 



Figure 16: Organisation and visualisation of different modalities: A) Bright-field 

micrograph of the root found in the soil sample acquired with the optical profilometer. B) 

The same field-of-view imaged with the helium-ion microscope. A close-up of the root was 

taken at higher resolution and registered (rigid) onto the overview image. C) Overlay of 

bright-field image and HIM (false coloured in blue). D) Topography map measured with 

the optical profilometer using a 100x air-objective registered onto the HIM image. The 

difference in height, form dark blue to red, amounts to 17 microns. E) Composite of 

chemical maps acquired by SEM-EDX registered onto the bright-field micrograph. F) 

Intensity map of CN- ions measured by ToF-SIMS deformed and registered onto the helium 

ion micrograph. 

Figure 17: Registration of ToF-SIMS data onto HIM: 1) The ion count (TIC) obtained 

from ToF-SIMS is very similar to the helium-ion micrograph. After rigid registration the 

difference image with HIM in green and ToF-SIMS in red shows a good correlation. 2) 

Applying this transformation model to the CN- ion distribution map. Deformable 

registration can locally improve the quality of the registration as shown by the results of 

global mutual information (3a) and bUnwarpJ (3b). 

Figure 18: Correlation of SEM-EDS maps: If element distribution maps measured by 

SEM-EDS are pixelwise multiplied additional chemical information can be gained. Here 

for instance, different aluminium silicates can be grouped into different types of feldspar 

with aid of the Na and K maps. Furthermore the correlation of Mg, Al and Fe maps hints 

to the presence of the mineral pleonast in the sample. The composite image of the gained 

mineralogical maps is shown in Fig. 18. 

Figure 19: Overlay of the helium-ion micrograph and mineralogical maps gained from the 

correlation of SEM-EDS chemical maps. Plant-cells in the root and pores are filled with 

resin (green, measured as carbon distribution map by SEM-EDS). The minerals in the 

vicinity of the root are quartz and different feldspar minerals. 
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Figure 1: Workflow for the registration of correlative micrographs using Correlia.
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Figure 2: Correlia’s graphical user interface.
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after import manual pre-alignment

registration using landmarks registration using MI

Figure 3: Illustration of the two possible ways for rigid body registration in Correlia.
The moving image only contains some geometrical objects (red) which are supposed
to align with the black objects on the chess board (target image). On the one hand
corresponding landmarks can be defined in both, moving image and target which will
be matched. On the other hand automatic registration using a mutual information
approach is possible after a manual pre-alignment.
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(A) definition of landmarks

(B) matching of corresponding landmarks

Figure 4: Rigid body registration using landmarks. A) At least three landmarks are
defined in in moving image and target. B) Afterwards, corresponding features have to
be matched. In the Match Features dialogue the user can either set the correspondences
manually or ask the software to guess. The feature correspondences are then displayed
with light blue lines in the viewer. The user acceptance of the correspondences will
calculate the coordinates x and y as well as rotation and scale that will register the
moving image onto the target.
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pre-aligned (rigidly registered) moving image

areal similarities in moving image and target?

YESNO

landmarks-based

de-warping

landmarks-matching might

lead to strong distortions in

the vicinity of the landmarks?

YESNO

landmarks bUnwarpJ

area-based

de-warping

localised or extended distortions?

localised extended

tile-matching
global mutual

information

Figure 5: Rigid body registration cannot lead to a proper image alignment if dis-
tortions are present in the moving image. However, this can still be achieved by sub-
sequently applying one or more of the deformable registration algorithms implemented
in Correlia to de-warp the moving imge. This flow chart shall help to select the most
suitable one for the given registration problem.

list of transformations

selected transformation

first transformation

parameters for the selected
transformation step

select reference image

edit image before transformation

compare source and target

delete transformation

transformation field

add transformation

load/save recipe

comparison of transformations

transform the image

add transformed image to list

back to main menu

Figure 6: Correlias graphical user interface for deformable image registration. Sev-
eral transformation steps can be cascaded and are listed on the left (here: tile matching
followed by landmarks). The chess-board image on the right displays the transformation
field. The parameters for the selected transformation are shown below.
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A) landmarks matching B) bUnwarpJ (img 0.0, lm 1.0)

C) bUnwarpJ (img 0.5, lm 0.5) D) bUnwarpJ (img 1.0, lm 0.0)

matching of landmarks

Figure 7: If a distorted moving image contains feature-points that have correspon-
dences in the target, landmarks can be defined in both and forced to align. Correlia
supports pure landmark-matching but also uses the external plug-in bUnwarpJ. The
latter offers the possibility to transform the moving image in different ways by putting
certain weight on image content (img) and landmarks (lm).
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target

moving image
rigid registration (MI)

tile matching, 4 tiles tile matching, 25 tiles

global MI, 4 def. handles global MI, 16 def. handles

Figure 8: Registration of a moving image with artificial areal distortions onto a non-
distorted but Gaussian-blurred target. After rigid pre-registration the moving image
was warped to align with the target. For that tile matching with 4 and 25 tiles as well as
global mutual information using 4 and 16 deformation handles were used, respectively.
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SEM SEM-EDS
phosphorous distribution map

secondary electron micrograph

Figure 9: Investigation of the distribution of phosphorous in a biofilm of Chlorella sp.
microalgae. A scanning electron micrograph (SEM, left) shall be overlaid with energy-
dispersive X-ray spectroscopy maps (SEM-EDS, right). For that the secondary electron
micrograph of the SEM-EDS data has to be registered onto the SEM image. Once that
is the done the same transformation can be applied to the phosphorous map which then
will be registered as well.

Figure 10, Rigid registration: Difference representation of the result of automatic
rigid registration of SEM-EDS-SE (red) onto the SEM image (green) taken on the algal
biofilm displayed in Fig. 9. Whilst the right side of the overlay aligns well, distortions
along the crack on the left of the overlay are obvious and call for further deformable
transformation.
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Figure 11, Deformable registration 1 (tile matching): Difference image of SEM
(green) overlaid with SEM-EDS secondary electron micrograph (red) of the algal biofilm
shown in Fig. 9 and 10 after the first deformable registration using the tile matching
approach. The tile-matching was carried out with 6× 6 tiles distributed over the source
micrograph allowing for full deformation scale. In particular on the left side of the image
a significant improvement of the registration was achieved.

Figure 12, Deformable registration 2 (landmarks matching): After rigid pre-
alignment (Fig. 10) and a deformable registration step (tile matching, Fig. 11) a final
deformable registration step using landmarks matching is employed to properly register
SEM image (green) and SEM-EDS secondary electron micrograph (red) acquired on a
Chlorella sp. biofilm. In the upper part of the figure the distribution of landmarks in
both micrographs is shown. The lower part shows the registration result after matching
them.
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Figure 13: Application of the transformation model obtained by deformable registra-
tion of the SEM-EDS secondary electron micrograph onto the SEM image measured on
an algal biofilm of Chlorella sp. microalgae (Fig. 12) to SEM-EDS phosphorous distri-
bution map (shown in red). This overlay with the SEM image shows that the microalgae
store excess phosphorous inside the cells rather than in the matrix of exopolymeric sub-
stances in the biofilm.
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Figure 14: Workflow illustrating the sequence of microscopic analyses of the soil sample
and at the same time the sequence of image registration applied to the so obtained
correlative microscopy data.

A B

Figure 15: Treasure maps acquired on the soil sample. A) Stiched bright field image
of the sample with the region of interest indicated and magnified. A root is found and
encircled in white. B) The bright-field image of the region of interest serving as canvas
(base image) for the Correlia project is overlayed with a helium-ion micrograph.
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A) bright-field

C) bright-field & HIM

B) HIM overview & root detail

D) HIM & topography map

F) HIM & ToFSIMS (CN−)E) bright-field & EDS

Figure 16: Organisation and visualisation of different modalities: A) Bright-field mi-
crograph of the root found in the soil sample acquired with the optical profilometer.
B) The same field-of-view imaged with the helium-ion microscope. A close-up of the
root was taken at higher resolution and registered (rigid) onto the overview image. C)
Overlay of bright-field image and HIM (false coloured in blue). D) Topography map
measured with the optical profilometer using a 100x air-objective registered onto the
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HIM image. The difference in height, form dark blue to red, amounts to 17 microns. E)
Composite of chemical maps acquired by SEM-EDX registered onto the bright-field mi-
crograph. F) Intensity map of CN- ions measured by ToF-SIMS deformed and registered
onto the helium ion micrograph.
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Figure 17: Correlation of SEM-EDS maps: If element distribution maps measured by
SEM-EDS are pixelwise multiplied additional chemical information can be gained. Here
for instance, different aluminium silicates can be grouped into different types of feldspar
with aid of the Na and K maps. Furthermore the correlation of Mg, Al and Fe maps
hints to the presence of the mineral pleonast in the sample. The composite image of the
gained mineralogical maps is shown in Fig. 18.
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Figure 18: Overlay of the helium-ion micrograph and mineralogical maps gained from
the correlation of SEM-EDS chemical maps. Plant-cells in the root and pores are filled
with resin (green, measured as carbon distribution map by SEM-EDS). The minerals in
the vicinity of the root are quartz and different feldspar minerals.
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HIM TIC CN−

rigid HIM-TIC rigid HIM-CN−

1 2
apply
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global MI HIM-CN− bUnwarpJ HIM-CN−

Figure 19: Registration of ToF-SIMS data onto HIM: 1) The ion count (TIC) obtained
from ToF-SIMS is very similar to the helium-ion micrograph. After rigid registration
the difference image with HIM in green and ToF-SIMS in red shows a good correlation.
2) Applying this transformation model to the CN- ion distribution map. Deformable
registration can locally improve the quality of the registration as shown by the results
of global mutual information (3a) and bUnwarpJ (3b).
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